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DLS SOPs 
Malvern Panalytical Zetasizer Ultra Rad 

 

Concise operating instructions 
1. Login to FOM 
2. Power on instrument 
3. Wait 30 minutes for instrument to warm up 
4. Prepare sample(s) during warmup period 
5. Select appropriate sample cell 
6. Load sample in correct orientation 
7. Set up measurement 

a. Required material information 
b. Required dispersant information 

8. Run sample(s) 
9. Remove sample(s) and clean area 
10. Power off instrument 
11. Export data, if required 
12. Logoff of FOM 
13. Data placed on the D-drive will be backed up 

every 30 minutes to the AMSEC data repository 
found by hitting the “Instrument Data” button on 
the AMSEC homepage  

14. All users must be familiar with the instrument 
hazards and best practices before operation. 

 
1.1. Instrument power 
 
2. Sample preparation 
3. Sample cells 
3.6. Cell orientation 
4.2. Measurements 
4.2.2. Material 
4.2.3. Dispersant 
4.4. Run a sample 
 
1.1. Instrument power 
5.3 Export data 
 
 
 
 
 
7. Instrument hazards and best practices 
 

 
 
Reference: Malvern Panalytical Zetasizer Advance Series User Guide  

https://amsec.wwu.edu/
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1. Instrument setup 
• The instrument must be warmed up for 30 minutes prior to use. When use is completed, you should turn off 

the instrument unless a user has it reserved later the same say. The 30-minute warmup needs to be 
accounted for in your FOM reservation. You must login on FOM at the time you are turning the instrument 
on for warmup. 

• Ensure that the sample cell in the instrument is clean and free of samples and other debris. Please report 
any untidiness to the lab manager. 

1.1. Instrument power 
• To power on and off the instrument. Simply press the black button located at the back of the instrument 

and to the right. It is not a toggle switch, but a single-press button. 

 

  

Power 
Power 

Indicator 
Light 

• The indicator light on the instrument should come on and pulse orange for a while as the instrument 
initializes and begins internal testing. There may be clicking sounds, this is normal.  

• The indicator light will turn green when the system is connected to the software and will turn blue when 
collecting data. 
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2. Sample preparation 
2.1. Sample concentration 
• Sample preparation is critical to obtaining reliable and accurate data with DLS. Proper preparation involves 

considering two main factors, particle size and sample concentration. The following table is a starting guide 
for sample preparation as recommended by the manufacturer. This is a starting point, and sample 
preparation may need to be altered based on specific circumstances. This table gives approximate values 
for a sample with a density near 1 g/mL and where the particles have a reasonable difference in refractive 
index to that of the dispersant. 

Particle Size Min. concentration Max. concentration (10 mg/mL = 1% w/w = 10000 ppm) 

< 10 nm 0.5 mg/mL Only limited by the sample material interaction, 
aggregation, gelation, etc. 

10 nm to 100 nm 0.1 mg/mL 50 mg/mL 
100 nm to 1 µm 0.01 mg/mL 10 mg/mL 
> 1 µm 0.1 mg/mL 10 mg/mL 
• Whenever possible, the sample concentration should be selected such that the sample develops a slightly 

milky appearance - i.e., becomes slightly turbid. 
• If such a concentration cannot be selected easily (for example, the particle size of the sample may be so 

small that even concentrated dispersions show no turbidity), various concentrations of the sample should 
be measured in order to detect and then avoid concentration dependent effects (e.g., particle interactions). 
A concentration should be chosen such that the result is independent of the concentration chosen. 
However, these effects do not normally appear at concentrations below 0.1% by volume. 

• Be aware that particle interactions may occur at sample concentrations larger than 1% by volume. Particle 
interactions will influence the results. 

 

 
 
  

• If you know the approximate concentration and size of particles, you can use this table as a guide to the 
concentration required. The minimum for very large particles (>500 nm) is about 500-1000 particles in the 
analysis volume. The horizontal bolded line is 100 particles. Samples shouldn’t be measure below that. 
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2.2. Multiangle DLS (MALDS) 
• This system is equipped with 3 different detectors for different light scattering angles. There is the forward, 

right-angle, and backscatter detectors. In MALDS, you measure all of them on one sample. This is only 
possible when using certain sample cell. See Section 3. Sample Cells for more info. 

• When attempting MALDS, you will have to have the concentration optimized to acquire data with all three 
detectors. 

Note: Due to concentration limitation, the recommended upper particle size that can be measured by MALDS 
is 500nm diameter. 
 

2.3. Small particles (<10 nm) 
• For small particles less than 10 nm in diameter, the major factor to consider for sample preparation is the 

amount of scattered light the sample generates. The appropriate concentration should generate at least 
10,000 counts per second (10 kcps) more than the dispersant. 

• The maximum concentration in this scenario doesn’t really exist in terms of performing a DLS 
measurement. In practice, the properties of a specific sample will set the maximum value as several things 
may happen to the sample at high concentrations when the particles are very small: 
o Gelation: If the concentration is too high, the sample may gel. 
o Particle interactions: If the particles interact with one another, the diffusion constant of the particles 

will change, leading to less reliable size results. 
 
2.4. Large particles (>500 nm) 
• For large particles, a low concentration limit doesn’t theoretically exist since a single particle can give 

sufficient scattering. This is not true in practice since the number of particles interacting with the laser is 
random between 1 particle and multiple. This will cause aberrant data to be collected often indicating a 
second population of much larger particles. 

• The upper limit of particle concentration is determined by the particles tendency to cause multiple-
scattering. Estimate the upper concentration with the previously provided table, but specific systems may 
still require more dilution. As a general rule, attempt to measure at the highest possible concentration so 
that potential contamination from the dispersant is overpowered by sample signal. 

 

2.5. Filtration 
• All liquids used to dilute the sample (dispersants and solvents) should be filtered before use to avoid 

contaminating the sample. The size of the filter will be determined by the estimated size of the sample. If 
the sample is 10 nm, then 50 nm dust will be an important contaminant in the dispersant. Samples may be 
filtered down to 20 nm using an appropriate filter. Chemical compatibility of the filter material should be 
considered when using non-aqueous solvents. 

• Samples are not filtered if possible. Filters can remove sample by absorption as well as physical filtration. 
Only filter the sample if aware of larger sized particles, such as agglomerates, that need to be removed as 
they are not of interest, or cause result variations. 
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2.6. Sonication 
• Ultrasonication can be used to remove air bubbles or to break up agglomerates - however, this must be 

applied carefully to avoid damaging the primary particles in the sample. Limits for the use of ultrasonication 
in terms of intensity and application time are strongly sample dependent. Minerals such as titanium dioxide 
are ideal candidates for dispersion by high powered probes, however, the particle size of some materials, 
such as carbon black, may depend on the power and length of time ultrasonication is applied. Some 
materials can even be made to aggregate using ultrasound. 

• Emulsions and liposomes should not be ultrasonicated. 
 

2.7. Zeta potential 
• Zeta potential background and theory will not be discussed in this document. You can read more about it in 

the user guide provided by the manufacturer on page 235. 
• The minimum and maximum sample concentrations that can be measured will depend on the following 

factors: 
o Optical properties of the particles 
o Particle size 
o Polydispersity of the particle size distribution 

• If the detector reads less than 10 kcps above the dispersant background signal, the concentration needs to 
be increased to obtain reliable data. 

 
2.7.1. Minimum concentration 
• The minimum count rate of scattered light is required to make a measurement is 10 kcps above the 

dispersant scattering level. Therefore, the minimum concentration required will depend upon the relative 
refractive index (the difference in refractive index properties of the particle and the medium) and the 
particle size. The larger the particle size, the more scattered light it produces and hence the lower the 
concentration that can be measured.  

• For example, consider a dispersion of a ceramic powder such as titania which has a particle refractive 
index of around 2.5. This relative refractive index results in a very high level of scattering. Therefore, the 
minimum concentration of titania with a mean particle size of around 300 nm that can be measured could 
be as low as 10-6 % w/v. 

• If the relative refractive index becomes lower, such as with proteins for example, the minimum 
concentration will be much higher. The Zetasizer can measure a minimum concentration of 1 mg/ml 
lysozyme, but some larger proteins can be measured at lower concentrations. 

• Ultimately, the minimum concentration required for successful zeta potential measurements of a particular 
sample must be determined experimentally. 

 
2.7.2. Maximum concentration 
• There is no simple answer for the maximum concentration for a zeta potential measurement in the 

Zetasizer. The factors discussed above, all must be considered - i.e., the particle size and polydispersity 
and the optical properties of the sample. 

• The scattered light from a sample in a zeta potential measurement is detected at a forward angle in the 
Zetasizer. Therefore, the laser beam must penetrate through the sample. If the concentration of the sample 
becomes too high, the laser beam will become attenuated by the particles, reducing the scattered light 
being detected. To compensate for these effects, the attenuator position in the instrument will be adjusted 
to a higher index - i.e., a higher transmission. 

• The reduced path length of the High concentration cell also allows higher concentration zeta potential 
measurements than either the Folded capillary or Dip cells. Ultimately, the concentration limits of any 
sample must be determined experimentally by measuring the sample at different concentrations and noting 
the effect on the zeta potential value. 
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• Many samples will require dilution and this procedure is critical in determining the final value measured. For 
meaningful measurements the dilution medium is very important. A measurement result given with no 
reference to the medium in which the material is dispersed is meaningless. The zeta potential is as 
dependent on the composition of the dispersed phase as it is on the nature of the particle surface. 

 
2.7.3. Dilution medium 
• Polar dispersants are those with dielectric constants greater than 20 such as ethanol or water. 
• Non-polar or low polarity dispersants are those with a dielectric constant less than 20 such as 

hydrocarbons or higher alcohols. 
 
• For any dispersant being considered, the aim is to preserve the existing state of the surface of the particles 

during dilution. Do this by filtering or centrifuging some clear liquid from the original sample and using this 
to dilute the original concentrated sample. In this way the equilibrium between surface and liquid is 
perfectly maintained. 

• If extraction of a supernatant is not possible, then just letting a sample naturally sediment and using the 
fine particles left in the supernatant is a good method. 

• Another method is to imitate the original medium as closely as possible. This should be done while 
considering: 
o pH 
o Total ionic concentration of the system 
o Concentration of any surfactants or polymers present 

 
• Measuring samples in insulating media such as hexane, isoparaffin, etc. requires the use of the universal 

dip cell. This is required because of its chemical compatibility and the close spacing of the electrodes which 
allows the generation of high field strengths without using excessively high voltages. 

• Sample preparation for such systems will follow the same general rules as for polar systems. As there will 
be generally fewer ions in a non-polar dispersant to suppress the zeta potential, the actual values 
measured can seem very high, as much as 200 or 250 mV. In such non-polar systems, equilibration of the 
sample after dilution is the time dependent step. Equilibration can take more than 24 hours.  
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3. Sample cells 
Note: Several of these cells are quite expensive and have very niche applications. Users should not use 
a cell that they have not been trained on by the lab manager. Failure to abide by this rule will cause 
the user to lose access to the instrument either temporarily or permanently. 

More information about cells can be found in the accessories guide. 
 

 
• For cells that list size, they can all use backscatter (NIBS), but not all can use the 90° and the forward 

scatter detectors. The cells that can use all the detectors have a check in the MADLS column. This is 
required to run concentration measurements as indicated by the corresponding concentration column. 
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3.1. Zeta cells 

 
 

3.2. Size cells 

 
 

3.3. Selection 
• Use disposable polystyrene cuvettes (DTS0012) for "easy to measure" samples. These samples will have 

relatively high scattering intensity, for example latex with 0.01% mass or higher. 
• Disposable cuvettes are not resistant to organic solvents. 
• Glass and quartz cuvettes have higher optical quality, which is vitally important when performing low 

concentration protein measurements (derived count rate <100 kcps). 
• Glass and quartz cells are resistant to organic solvents and can be used at higher temperatures. 
• The polystyrene cells are low cost, disposable, and do not require cleaning. 
• Glass and quartz cells require cleaning after a measurement. 
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3.4. Cuvette specs 

 
 

3.5. Cleaning cells 
Cleaning cells should follow the procedure outlined to each user when they are trained on how to use each 
cell. In general, rinse cells before use with filtered dispersant and rinse then after with clean dispersant 
followed by water. In the case of organic solvents, they can be left to dry instead of rinsing with water after as 
long as they don’t leave residue. For disposable cells, rinsing isn’t required except in the case that the sample 
needs to be rinsed out as waste. If the sample is inert and not considered chemical waste, it can be disposed 
of directly. 
 

3.6. Cell orientation 
All cells must be oriented correctly when inserting them into the instrument to ensure the proper face is toward 
the laser and detector(s). Some cells only have one orientation that will work. If the cell has an arrow on it, that 
will face the front of the instrument. If the cell has the Malvern Panalytical logo on it, it will either face the front, 
or if it is on top, it will be oriented with the points toward the back of the instrument and the flat section to the 
front. 

 
Standard 

Cell 
Low Vol. 
Capillary 

Disp. Flow 
Zeta 

High Conc. 
Flow Zeta 

Zeta Dip 
Cell 

 
  

Front To front 
Front 

Front 
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4. Software use 

 
• The software is call ZS Explorer. Upon opening the software, you will be in the Home tab. The Home tab 

has links to manuals and shortcuts to some basic measurements. 
• The Measure tab is where measurements will take place. 
• The Studies tab is for data trend analysis. 
• The Analyze tab is where you can view, import, and export data as well as generate reports. 
• Report designer is for modifying report views and generally shouldn’t be used. 
• The Instrument tab has information about the instrument. This is generally not used by the standard user. 
 

4.1. Data management 
• All the data on this computer is saved within one database. This means that all users will have access to all 

data. This also means that we need to be vigilant about keeping the data organized so that it isn’t a mess. 
If it becomes too messy, we may need to export all data and start over. 

• All data is stored in Projects. In general, all users will have their own project. We should attempt to keep 
the project names organized in a way that will reduce confusion. Recommended naming would be: 

 

 

 
  

ResearchAdvisor_UserName_ID i.e., Montano_Mikkelsen_01 or Montano_Mikkelsen_TiO2 

• With the increasing number of projects, it will help to have a set format to sort data and find relevant files. 
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4.2. Measurements 
Measurements take place in the Measure tab. Ensure that you save your data to the correct project as it can’t 
be deleted out of another user’s project after it has been collected. 

 

 

  

• From left to right, the icons at the top of the Measure tab are: 
o New Method: This will clear the current method and you will start over 
o Open Method: You can open a saved method. 
o Save Method: To save the currently configured method to use as a template later. 
o Save Method As: To save a saved method with a different name. 
o Copy Method: Sometimes, when a method has been used several times, it will not let you use it as is 

and you will hit copy before it lets you run it. You will know this is the case if you have everything 
configured, but the play button is greyed out. 

o Start Method: This starts the measurement. It will only be green when conditions are met to measure. 
Get screenshot with green play button 

• Name your sample. This is not the method name, 
but the sample name. 
• Add parameters is a data input section entirely for 
your own uses. You can add things such as the batch 
number, data created, amount of reagent used, etc.  
• Cell, Material, and Dispersant are discussed later in 
this section. 
• Select the project in which to save the data. If you 
are creating a new project, it won’t be officially saved 
until data is saved within it. You can also create a 
project form Section 5. Analyze Data. 

4.2.1. Cell 
• The cell dropdown allows you to see 
an image of the cell if you hover the 
mouse over it. 
• The cell that you choose will limit 
what measurement options are 
available. This is based on the 
capabilities of the cell. 
• The cell you choose will also limit 
temperature capabilities based on what 
that cell can handle. 
• All containers with cells in them 
should have the part number so you can 
also ensure you have the correct one 
that way. 
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4.2.2. Material 
• The material is what your analyte of interest is made of 
such as gold nanoparticles or latex beads. 
• Select the material from the dropdown list. If the one you 
want doesn’t exist, see Section 4.2.4. Adding materials and 
dispersants. 
• You can search for the material by typing in the search bar. 
 
 

 

  

4.2.3. Dispersant 
• The dispersant is the liquid containing your analyte. It is 
not referred to as the solvent in the software because your 
particles are not dissolved. 
• Select the material from the dropdown list. If the one you 
want doesn’t exist, see Section 4.2.4. Adding materials and 
dispersants. 
• You can search for the material by typing int eh search bar. 
• The available dispersants will be limited based on what cell 
you selected. If you are trying to use an organic solvent in a 
plastic cell, the software won’t let you select it because they 
are incompatible, and the liquid would start to dissolve the cell 
making the measurement impossible. 
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4.2.4. Adding materials and dispersants 
• dispersant You will be required to add a new material or 
dispersant if the one you want to analyze does not exist in the 
dropdown lists. 
• Each material and dispersant have unique optical 
properties that are factored by the software to ensure that your 
results are as accurate as possible. 
• To add a material or dispersant, first expand the dropdown 
list. Then select the pencil icon next to a material or under the 
magnifying glass icon. 
• You can delete user-created materials and dispersant by 
clicking the X that will show up next to the pencil. The 
manufacturer loaded entries cannot be deleted and will have 
the green Malvern hills logo. 
 
 
 

 

  

• For Dispersants, enter a name. Please use something 
that other users would associate with the material. 
• You will also need to enter the Temperature Range that 
the dispersant can be used at, the Refractive Index, and the 
Viscosity at 25 °C. 
• You will also need to check the box related to the 
dispersant being water based. 
• Then choose whether the dispersant is compatible with 
plastic cells. Most plastic cells are polystyrene, so compatibility 
is generally only with aqueous solutions and isopropanol. 
• You will not need to enter the Zeta values if the dispersant 
is not zeta potential compatible. 
• If you select OK, the dispersant won’t be saved to the 
database for future use but will be used only for the current 
run. If you select Add to Database, the dispersant will be 
saved for future use. 
• The  icon can be used by hovering the mouse over for 
more information on the parameters that need to be entered. A 
comprehensive table is located later in this section. 
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• For Materials, enter a name. Please use something that 
other users would associate with the material. 
• You will also need to enter the Refractive Index and the 
Absorption. 
• If you select OK, the material won’t be saved to the 
database for future use but will be used only for the current 
run. If you select Add to Database, the material will be saved 
for future use. 
• The  icon can be used by hovering the mouse over for 
more information on the parameters that need to be entered. A 
comprehensive table is located later in this section. 
 

Detailed information about dispersant and material parameters is located on the following tables. 
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4.3. Method builder 
Note: If a measurement type is greyed out, your cell isn’t compatible with that measurement. Less 
commonly, the dispersant might not be zeta potential compatible which would also grey that option 
out. 

• The method builder is used to stepwise add 
in the measurements you would like to perform on 
a single sample. This method can be saved for 
future use once dialed in. Typically, they are quite 
simple, but can get complex, especially if 
performing titrations. 
• Simply select the measurement step from 
the left side. Some of the measurement types will 
have multiple options once selected as shown. 
• Once selected, a step will show up in the 
Method Builder section. The properties pane will 
also show up if it wasn’t there before. 
• Select as many steps as you would like to 
add to the method builder. They will be ran in the 
order shown and data saved automatically. 

 

 
• The steps can be reordered by dragging the right side where the three horizontal lines are. You can delete 

the steps by clicking the X. 
• The step can also be duplicated. This is best after the step has been customized as all settings are copied. 

• The number of replicates is shown with the  icon. This can be clicked to change the number to a 
preset value of 1, 3, or 5, or you can enter any value required. This is how many total measurements will 
be taken. 
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• Clicking on a step will allow you to modify the step properties. 
• The top section has information about the temperature to acquire 
data at. Depending on the cell, you will be limited on the range you 
can select. Until the system is hooked up to a proper dried air supply, 
we will not be cooling below room temperature. 
• Equilibration time should be set to allow the cell and contents to 
equilibrate at the selected temp. If near room temp, a time of 30 
seconds should be sufficient. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

  

• Set the appropriate data processing type. This affects the data 
collected. If you are unsure, leave it as General Purpose. Otherwise, 
read the descriptions or go through the user guide. 

• Advanced settings will be hidden by default, and you can expand 
it by clicking the arrow. 
• The angle of detection can be changed here. Back scatter is 
generally the best choice. If you are doing MADLS, you won’t be able 
to change the angle since it will use all of them. 
• Leave all other settings as default unless you have read through 
the user guide more in depth or have consulted with the lab manager. 
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4.4. Run a sample 
• Once you have prepared your sample and built your method, you are ready to run the sample. 
• Insert the sample into the instrument by opening the cover with the green button just behind the indicator 

light. 
• Before inserting, ensure that the sample slot is free of debris and contamination. Stop use and report any 

issues to the lab manager right away. 
• Ensure that you insert the sample cell in the correct orientation. 
• Close the lid. 
• Press Start Method.  

 

 

  

• The bottom bar of the instrument will show the current status as well as the instrument log readout which 
displays live information about collection. 

• You can also stop the run from here. 
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• As the run progresses, you can see the data being collected on the plots in the main panel of the software. 
This document will not go into depth about their meaning and what they should look like. You can read 
more about that in the User Guide. 

 

 

• Once the run completes, the instrument will beep and the software will stop. You can see the results of 
your data in the Analyze tab. 

• To run another sample, you can either click the New Method 
button which will take you to a blank method, or you can click on the last 
used sample name from the Method List on the right of the screen in the 
Measure tab. 
 
  

v 
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5. Analyze data 
In the analyze tab of the software, you will be able to view, import, and export data. The data is stored on the 
computer in a database. Unfortunately, we aren’t able to specify the database location so saving it to a network 
location isn’t possible to create a sharable database. If you want to have a database on your computer, you will 
first need the software and then you can import data into a project. This is covered more later in this section. 
 

5.1. Projects 
• All data is saved into a project. Each user can have multiple projects, but we need to keep it to a 
minimum or else the database will get messy and we may have to wipe it. See the section on Data 
Management for info on the projects and how we should organize them. 
• There are two ways to create a new project. The first has been outlined in Measurements. The 
second is from the Analyze window. When you enter the analyze window, the last used project will 
already be loaded. Simply click on the vertical Explorer bar on the left of the screen and it will expand. 
 
 
 
 
 
 

• Once expanded, you will see all the 
projects saved on that computer.  
• You can search through them in the 
search bar.  
• Once you select a project, the data 
contained within will show to the right.  
• You will want to minimize the 
explorer again by clicking on it once you 
select or create the desired project. 
• This is also the place where you can 
create, rename, delete, and export a 
project. 
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5.2. Viewing data 
• After selecting a project, you will be able to view the data contained within. 
• The table on the left of the screen will list all the runs in that project. 
• You can sort the samples by name, date ran, etc. 

 

 

• When you select a sample, the data will display to the right. The summary tab will open by default, but after 
that the last used tab will be used. 

• You must select the data type that was collected. If you ran a size measurement, the zeta tab will not 
display anything and vice versa.  

• You can then see the data and export it or just write it down. Exporting is covered later in this section. 
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5.3. Exporting data 
There are several ways to export data. Some users will be fine with writing down the stats from a run, but 
others will want a report document and others will want the raw plot data. These are all possible. You can also 
export the data to another computer to view in the same software. 
 
5.3.1. Reports 

• Reports are simple ways to export all the information for a run and 
present it in a concise manner. They are not ideal for publication 
though. 
• Once you have selected the data to export to the report, select the 
report button above the leftmost plot. This will open up a list of 
available reports. If you want a report customized for later use, ask the 
lab manager. 
 
 

 

 

 
 
  

• Select the report you would like to use. All the report names should start with the type of measurement 
taken. Therefore, do not choose a report that says Zeta at the beginning if you ran a Size measurement.  

• For standard Size measurements, choose the Size-Quality Report. 
• Once you select the report you want, you’ll print to a .pdf with the printer icon and choose where to save it. 

Remember to save data to the D-drive. 
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5.3.2. Raw data 
• Users can export raw data from any plot or table in the software where data is viewed. You cannot export 

the table as a .csv that contains your list of samples. 
• Click on the ellipsis at the top right of a plot and choose the Cope Data option. This will copy the required 

data to the clipboard and then you can open an excel sheet and paste it in. 

 

  

• For tables of data, you will also click the ellipsis, but instead of copy data you’ll see Export data to CSV. 
This will open a dialogue asking where to save the table. Remember to save data to the D-drive. 
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5.3.3. Database export 
• Exporting the database file is used to later import the data into another project either on the same computer 

or on a different one. 
• This can also be used to clean up your project organization. For example, if only 20 or my 100 runs on my 

project are viable data, I can export those 20 runs, delete the project, recreate the project, and then import 
the good runs. 

• You can export one file at a time, or you can select multiple and export them together as one file. 
• Begin by selecting on or more files from your project. 

 

 

 

 

• Once highlighted, click the Export Selected Results button and you will be prompted with a dialogue asking 
where to save the data. Remember to save data to the D-drive. 

• This data file has an extension of .zmes which can only be opened in this software. 

5.3.4. Database import 
• To import data into a project, you first must have a project selected in the Explorer pane. If no project yet 

exists, create one. Ensure you have the correct project selected as once you import data into a project, you 
cannot delete the data. 

• The data you wish to import must be in the proprietary file format of a .zmes file.  
• The data you wish to import must be copied into the import folder for the software. Unfortunately, the import 

folder location is fixed and is somewhat difficult to find. On the instrument PC, there is a shortcut on the 
desktop labeled “Import data”. This will open the folder where you can drop data to import. 

• On any other computer, the import folder location is defaulted to the following: 
C:\ProgramData\Malvern Instruments\ZS XPLORER\ 

• If the software was installed and the settings changed to an individual database type, then the location may 
be different and can be found in the software options in the storage tab. 

• Once you have copied your data into the appropriate folder, change your view to the import tab in the 
explorer pane. You may have to hit the refresh icon to get your file to display. Other files may be here also. 

• Choose your file to import and choose the import button. If you are warned about duplicate files, just hit 
yes. Your data has been imported successfully.  
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6. Titration accessory 
To be added at a later date. Users will be trained on an individual basis for this accessory and no user should 
use it without the lab manager’s authorization. Failure to abide by these rules will result in temporary or 
permanent loss of privileges. 
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7. Instrument hazards and best practices: DLS 
This document will cover the inherent hazards when utilizing this piece of equipment as well as the best practices and 
procedures to avoid danger. These hazards will not include basic things that may be included in the basic safety training 
document that each user has attested to have reviewed at fom.wwu.edu/documents. 
Lab coats are to be provided by the user unless special hazards exist in which case, they are located at the PPE 
station. 
 
Hazards: 

- Chemical exposure 
- Laser radiation: 632.8 nm Class 1 

 
1. Required PPE 
 Appropriate laboratory attire is required at all times in the AMSEC laboratories. Whenever chemicals are being 
used, an additional requirement of a lab coat is required. Lab coats are to be provided by the user. 

Whenever a user is in the AMSEC labs in ES 128, the minimum requirement for eye protection is wrap around 
impact glasses. Anytime liquid chemicals are present in the same room as the user without a direct barrier, all users in the 
lab must wear chemical splash goggles. Splash goggles must be approved by State of Washington Administrative Code 
(WAC 296-24-078). 

If chemicals being used are considered toxic, caustic, corrosive, flammable solvents, carcinogenic, mutagenic, or 
teratogenic, a minimum of disposable nitrile gloves is required. Avoid chemical transfer by taking off gloves when using 
anything other than the chemical(s). 
 
2. Laser radiation 
 The DLS is equipped with Class 1, 10 mW, 632.8 nm HeNe laser. This system is designed with many interlocks 
and safety devices in place to prevent users from ever being exposed to the laser. Under normal operation, the chances 
of being exposed to the laser are almost zero. If any interlocks are not satisfied and cannot be remedied by the user, the 
lab manager must be notified, and the user should cease use of the system immediately. 

At no time should anyone tamper with or attempt to dismantle or repair any part of the instrument. Failure to follow 
these instructions could lead to injury and loss of privileges. 
 
 

http://fom.wwu.edu/fom/documents
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